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1. Установка и пути к данным. 
 
Программа MoTeC i2 Pro устанавливается в дополнение к ранее установленной игре. 
 
Для того чтобы задействовать MoTeC необходимо в меню “Options → Advanced”(“Опции → Дополнительно”) 
включить функцию “Race Data Acquisition”(“Сбор гоночных данных”). 
 
Файлы записей (Log Files) 
 
После установки MoTeC использует ранее заданный путь к данным. Это означает, что если ранее был установлен 
GTR1, то путь по умолчанию будет: 
 
C:\GTR\MoTeC\Logged Data 
 
Его можно поменять в *.plr файле используя “Блокнот” (“Notepad”). 
 
По умолчанию этот файл находится в папке C:\GTR2\Userdata\<Имя профиля>\< Имя профиля >.plr 
 
Выделенная жирным строка отвечает за то где будут сохраняться Файлы Записей 
 
Data Acquisition Version="0" // Version of vehicle data to write out 
Data Acquisition Rate="10" // rates 1, 2 ,5, *10*, 20, 50, 100 
Data Acquisition In Race="1" 
Data Acquisition EXE="C:\Program Files\MoTeC\i2\1.0\motec.exe” 
Data Acquisition File="userdata\vehicledata.spt" 
MoTeC LogFolder="C:\Games\GTR2\MoTeC\Logged Data" 
MoTeC Minimum Time="20" // minimum MoTeC recording time (sec) 
MoTeC Multiple Logs="1" // generate unique filename for each new log 
 
2. Открытие файла 
 
К этому руководству приложен типовой проект  “GTR2 Analysis” 
 
После запуска MoTeC выберите “Open an existing project” далее укажите путь к “GTR2 Analysis” 
Далее откройте Файл с записью с расширением *.id, для этого выберите  “File → Open Log File“ 
После этого появится список со всеми доступными Файлами Записей. 
 
Этот список можно отфильтровать, используя три выпадающих меню: 
 

1. Фильтр по названию трассы. (Название трассы отображается в виде год + название трассы, т.е. если реально 
трасса называется Donington 2004, то она будет отображаться как 4Donington) 

2. Фильтр по имени пилота. Для GTR2 это имя профиля. 
3. Фильтр по используемой машине. (Название машины отображается в виде год + номер машины, т.е. если 

машина в игре это 2003 #51 Freisinger Porsche GT3 RS, то в MoTeC это будет отображаться как 03051) 
 
Полный список кодов GTR2 находится в Приложении 2. 
 



Так же, нажав на кнопку “Options”, можно выбрать какие данные о записях будут отобрахаться в списке. 
 
Далее добавьте необходимые файлы из раздела “Log files” в раздел “Selected files” и нажмите на кнопку “Open”. 
 
3. Полезные инструменты 
 
Настройки машины 

 
Рис. 1.Просмотор использованных настроек машины. 
 
Чтобы посмотреть какие Настройки машины использовались при создании Файла записи необходимо выбрать “Tools 
→ Details → Edit → Vehicle” 
 
После этого появится окно с Настройками машины. Вы можете прокручивать лист вверх и вниз, используя кнопки 
“Вверх-вниз” на клавиатуре (т.к. скроллинг на мышке не работает)  или увеличить окно так, как это показано на 
рисунке выше. 
 
Времена кругов и фильтры 

 
Рис. 2: Просмотр и фильтрование времен круга. 
После того как файл был открыт, вы можете посмотреть свои времена на круге, щелкнув по закладке “Data” 
 
Если вы открыли несколько файлов то в списке, соответственно, будут отображаться сразу несколько сессий. 



 
Щелчок правой кнопкой мышки на времени приведет к появлению меню позволяющего фильтровать ваши времена. 
Если вы хорошо едите по трассе, то ваши времена должны быть как можно ближе друг к другу т.е. должны попадать в 
1% от быстрейшего, чтобы просмотреть эти круги  выберите “Filters → Show Within 1% of fastest”. Для того чтобы 
снова отобразить все времена выберите “Filters → Show All” 
 
Наложения (Слои) 
 
Для сравнения нескольких кругов отметьте один или несколько переключателей: Красным показан базовый круг, в то 
время как остальные выбранные круги будут отображаться другими цветами (например, синим, зеленым т т.п.) 
 
Черным показан круг, с которым обычно производится сравнение. 
 
Если вы выберете слишком много слоев, то сравнение показателей станет затруднительным, поэтому лучше всего 
одновременно отображать не более 2 – 4 слоев. 
 
Данные по каждому кругу появятся справа в списке каналов, так же как и на остальных диаграммах и графиках где 
они будут отображаться выбранным цветом (черным, зеленым, синим и.т.п.) 
 
Добавление графиков и гистограмм 

 
Рис. 3. Добавление новой области для  графика или гистограммы  на рабочий лист. 
 
Для того чтобы добавить новый график или диаграмму на рабочий лист нужно щелкнуть ПКМ на пустой части 
рабочего листа или выбрать “Add” в панели инструментов. После этого появится меню позволяющее добавить новую 
область данных. 
 
Это может быть Time/Distance graph ( График Время/Дистанция), Histogram (Гистограмма) или Scatter Plot (Точечная 
диаграмма) или вы можете добавить движущуюся область такую как указатель скорости из меню шаблонов (Gauge 
menu). 
 
 
 
 
 
 
 
 
 
 
 
 
 



Добавление канала  

 
Рис. 4. Добавление канала. 
 
Для того чтобы добавить новый канал на график нужно щелкнуть ПКМ на графике и потом выбрать “Properties → 
Channels → Add Channels” или щелкнуть ПКМ на названии необходимого  канала в области каналов, а затем выбрать 
“Add Channel to Component” 
 
Это меню позволяет вам выбрать слой, объединить каналы в группы и установить для них масштабы. 
 
Лучше всего каналы с разными данными держать в разных группах т.к. слишком большое количество слоев в одной 
группе затрудняет восприятие данных и может вызвать проблемы с масштабом (например, если поместить график с 
выбранной передачей (его значения 1-6) в одну группу с графиком, отображающим обороты двигателя (его значения 
4000-9000) то в результате отследить передачу будет невозможно т.к. это будет прямая линия) 
 
После добавления канала используйте кнопки “Move up” и “Move down” для перемещения канала в нужную группу. 
 
Нажатие на кнопку “Edit” позволит вам выбрать свойства выделенного канала такие как цвет, ручное/авто 
масштабирование и единицы измерения. Если при этом был выбран не канал, а группа то это позволит вам  
установить размер графика и выбрать ручное/авто масштабирование (Ручной масштаб группы заменит ручной 
масштаб канала входящего в эту группу) 
 
Для того чтобы скрыть/отобразить канал нажмите ‘V’ 
 
Переключение между кругами 
 
Когда в сессии записано более одного круга они появляются в верхней части экрана. 
 
По умолчанию обычно выбирается самый быстрый круг. Для переключения между кругами вы можете использовать 
кнопки “Next” и “Previous” или клавиши ‘N’ и ‘P’. Зеленая подсветка показывает выбранный круг. 
 
 
 
 
 
 
 
 
 
 
 
 
 



О важности масштабов 

 
Рис 5. Окно редактора каналов. 
 
Когда просматриваешь телеметрию используя MoTeC i2 Pro, очень важно убедиться чтобы  масштабы были заданы 
верно. Разные графики можно отображать как в метрической так и в имперской системе для этого необходимо 
выбрать “Tools → Channel Editor” 
 
Различные классы машин и трассы в GTR2 имеют разные характеристики поэтому можно поэкспериментировать с 
масштабами чтобы добиться лучшей наглядности в каждом конкретном случае. 
 
Для настройки отображения канала выберите его и нажмите кнопку “Edit” 
 
Для просмотра графиков и гистограмм вам часто будет нужно настраивать масштаб для более детального 
отображения. 
 
Цель этого – показать данные так четко как это возможно, проще всего это реализуется когда график занимает всю 
свободную область. 
 
Когда сравниваются такие данные как положение подвески для всех четырех колес находящиеся близко друг к другу, 
часто бывает полезным задать масштаб вручную так, чтобы оси графика были одинаковыми для всех колес. Если же 
масштабы не совпадают то тогда, то, что отображается на экране, может ввести вас в заблуждение и поэтому будет 
сложнее улучшить настройки. 
 
Карта трассы 

 
Рис. 6. Отображение увеличенной области на карте трассы 
 



Карта трассы создается в правом нижнем углу экрана. Она создается исходя из записанных данных во время первого 
проезда по трассе. Иногда необходимо потратить немного времени, для того чтобы убедиться, что карта отображается 
правильно. 
 
Блокировка колес и развороты иногда могут привести к тому, что карта будет совершенно неправильной и ее сектора 
не будут совпадать с реальными данными. 
 
Если это произошло, то откройте круг без аварий и разворотов и щелкните ПКМ на карте в правом нижнем углу 
экрана и выберете “Track Editor → Generate Track” и потом нажмите на кнопку “OK” чтобы перерисовать карту 
трассы. 
 
Красная точка показывает где находится указатель на трассе. Ее можно перетаскивать используя мышь. 
 
Когда часть трассы выделена жирной линией а остальная часть тонкой это значит что какой то из графиков был 
увеличен. 
 
Функция увеличения 

 
Рис. 7. Увеличение части графика 
 
Для увеличения части графика нужно дважды щелкнуть ЛКМ на графике и переместить мышь в результате появится 
черная подсветка, которой будет выделена интересующая часть. Еще один щелчок ЛКМ увеличит выделенную 
область. 
 
Для того чтобы передвигать увеличенную зону по графику нужно зажать ‘Shift’ и использовать кнопки ‘Лево-право’ 
 
Увеличенная часть круга подсвечивается на карте в правом нижнем углу экрана черным цветом  
 
Красная точка на этой карте показывает место положения курсора. Ей соответствуют показатели отображаемые в 
области каналов под красным маркером. 
 
Щелчок ПКМ  на графике и выбор меню “Zoom → Horizontal Zoom Default” приведет к тому, что круг снова будет 
показан целиком. 
 
Также возможно увеличить часть графика зажав ‘Ctrl’ одновременно с двойным щелчком ЛКМ на графике, далее 
нужно только растянуть черный прямоугольник, поверх интересующей части графика. 
 
Снова отдалите график  сделав щелчок ПКМ  на графике и выбрав меню “Zoom → Vertical Zoom Full Out”. Эта 
команда применяется только к выбранному каналу, поэтому если вы приближали остальные каналы вы должны 
повторить эту команду для каждого из них. 
 
 
 



Отображение разницы 

 
Рис. 8. Отображение разницы по времени между двумя кругам 
 
С помощью этой функции можно посмотреть совокупную разницу по времени между двумя кругами. Это полезно в 
случае, когда время не было получено или было утеряно.  
 
Для того чтобы показать или скрыть разницу между кругами щелкните ПКМ на графике и выберете “Display → Show 
Variance”. 
 
Положительные значения означают, что базовый круг быстрее, а отрицательные что он медленнее. 
 
Для ручного изменения масштаба Графика разницы щелкните ПКМ на графике и выберете “Properties → Display” 
далее в появившемся окне поставьте галочку “Manual Scale Variance”. 
 
Если временная разница между кругами слишком большая, то это может быть вызвано неправильной интерпритацией 
данных. В этом случае полезно использовать инструмент “Смещение данных”  
 
Смещение данных 

 
Рис. 9. Несовпадение меток конца круга на двух кругах 



 
Это очень полезная функция которая позволит вам сравнивать специфические сектора на круге. 
 
Различные траектории в поворотах и блокировки колес могут вызвать сдвиг графиков относительно друг друга. Это 
приводит к явному сдвигу метки конца круга, что может вызвать затруднения при анализе того, что же случилось на 
самом деле. 
 
Щелкните ПКМ на графике и выберете “Data Offset → Show data offset axis” 
 
Несколько осей появятся под графиком. Перетаскивание этих осей друг относительно друга позволяет вручную 
настроить привязки графика. Нахождение контрольной точки, такой как начало зоны торможения,  в середине трассы 
и привязка к ней графика позволит вам лучше сопоставить два круга, когда времена на них отличаются более чем на 
секунду. 

 
Рис. 10. Использование Смещения данных для сопоставления кругов основываясь на торможении перед  9-ым 
поворотом  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4. Рабочая книга GTR2 Analysis Sample  
 
Модель проекта GTR2 разделена на три группы: Анализ вождения, Установки и Подвеска. 
 
Группа Анализ вождения концентрируется на том, как хорошо работает пилот, группа Установки – как машина 
управляется, и группа Подвеска помогает в тонкой настройке машины. 
 
GTR Analysis 

 
Рис. 11. Рабочий лист GTR Analysis 
 
Лист GTR2 Analysis показывает действия водителя на протяжении круга. На нем отображены пять основных 
показателей Corrected Speed (Текущая скорость), Throttle position (Положение газа), Brake Pedal Position (Положение 
педали тормоза), Gear (Передача) и Engine RPM (Обороты двигателя). 
 
Текущая скорость показывает, как быстро машина двигается и ускоряется она или замедляется. Вершины показывают 
быстрейшие места на каждой прямой, а впадины самые медленны места в каждом повороте. Положение курсора на 
карте отображается в виде красной точки. Это позволяет вам определить положение машины на трассе. 
 
При сравнении двух кругов на этом графике видно на каком круге и где вы были быстрее или медленнее. Даже 
незначительная разница в скорости может означать удивительно большую разницу во времени на круге. 
 
Графики положение педали газа и тормоза показывают, что делает водитель. Цель этих графиков -  следить за тем, 
чтобы работа газом или тормозом всегда была правильной для достижения быстрейшего времени на круге. 
 
100% Положение газа означает, что машина разгоняется, а 0% что машина катится по инерции. Часто быстрое и 
небольшое добавление газа в середине поворота позволяет сохранить стабильность машины и не превышать уровень 
сцепления покрышек с асфальтом. 
 
Если в игре включено Автосцепление (Auto clutch) то машина будет автоматически делать перегазовку при каждом 
переключении передачи вверх или вниз в результате на графике газа появятся скачки. 
 
График положения педали тормоза показывает где были использованы тормоза. 100% означает что возможности 
тормозов используются полностью, а 0% что тормоза не используются. 
 
Обычно для того чтобы убедится что машина замедляется так быстро на сколько это возможно и в тоже время 
отсутствует блокировка колес этот график используют совместно с графиком скорости вращения колес. 
 
В конце торможения  обычно лучше немного отпустить тормоз с целью предотвращения блокировки колес. 
 
График Передачи показывает какая передача включена. -1 это задняя передача, 1-6 передние. 
 



Цель этого графика в том чтобы, используя передачи, держать обороты двигателя в оптимальном диапазоне на всем 
круге. Каждое повышение передачи приводит к небольшой потере ускорения, в то время как передача 
переподключается. Поэтому иногда вам может показаться, что вы едите быстрее, а на самом деле, большое 
количество переключений коробки вверх, может привести к потере времени на круге. 
 
Понижение передач может помочь замедлить машину используя “торможение двигателем” но слишком быстрое 
переключение может привести к перекрутке двигателя и в итоге к его поломке. 
 
График Оборотов двигателя показывает как быстро вращается двигатель и как хорошо выбранные вами передаточные 
отношения коробки передач соответствуют требованиям трассы. Передаточное отношение первой передачи должно 
позволять проходить на ней самый медленный поворот трассы, а передаточное отношение последней передачи 
должно позволять достигать на ней максимальных оборотов двигателя в конце самой длинной прямой на трассе. 
 
Хотя установки лимитатора оборотов двигателя в гараже влияют только на момент переключениях вверх, однако, в 
тоже время они позволяют при необходимости немного перекручивать двигатель и при переключении вниз. Эта мера 
безопасности служит, для того чтобы устранить внезапные переключения вниз уничтожающие двигатель, но 
повторяющиеся быстрые переключения вниз гарантированно приведут к поломке двигателя. 
 
Виртуальная панель приборов (Virtual Dashboard) 

 
Рис. 12. Виртуальная панель приборов 
 
Она показывает то, что происходит на трассе в реальном времени. Это полезно для быстрого обзора и может помочь 
понять ответные реакции машины. 
 
Скорость воспроизведения может быть настроена при помощи панели управления скоростью в верхней части экрана. 
 
Новые приборы могут быть добавлены при помощи щелчка ПКМ на свободной части экрана и выбора меню “Add → 
Gauge”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Время на секторах (Section times) 

 
Рис. 13. Время на секторах 
 
Этот лист показывает список времен на круге на каждой отдельной прямой и в каждом повороте. 
 
Времена подсвеченные синим это быстрейшие сектора, они все выносятся в раздел Eclectic. Сумма этих времен это 
ваш теоретический лучший круг т.е. цель к которой нужно стремиться. 
 
Темно-зеленые секторы это секторы попадающие в 2% от лучшего результата, а светло-зеленые в 1%. 
 
Красная линия показывает быстрейший круг сделанный из смежных секторов. 
 
Щелчок ПКМ на списке и выбор пункта “Properties” позволят вам отфильтровать эти данные несколькими 
различными способами. Для примера можно показать только повороты или только прямые. 
 
Когда выбран круг для сравнения,  то есть возможность сравнить секторы с секторами основного круга “ПКМ → 
Properties → Report → Check the selected data radio button” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Анализ шин (Tire Analysis)  

 
Рис. 14. Анализ шин 
 
Здесь показано как температура и давление шин меняются на протяжении круга. Это полезный гид по тому как 
машина управляется. В идеале температура и давление всех четырех шин должны быть одинаковыми после 
нескольких кругов. 
 
На практике это обычно не возможно, потому что трасса, например, имеет больше левых поворотов, чем правых  и т.д 
 
Оптимальная температура шин это 90ºС, а оптимальное давление 200 кПа. После 4-5 кругов температура внутренней 
части шины должна быть выше температуры внешней части на 3-5ºС, а температура центральной части шины должна 
находится между ними. 
 
В начале сессии покрышки холодные и во время сессии они постепенно прогреваются и достигают своей рабочей 
температуры. Когда шины холодные это приводит к уменьшению сцепления с трассой, а если они наоборот слишком 
горячие, то поведение машины становится непредсказуемым. 
 
Если температура центральной части шины ниже температуры внешнего края это означает, что шина недокачана и, 
следовательно, нужно добавить давления, а если температура центральной части шины выше температуры 
внутреннего края то это означает, что шина наоборот перекачена и, следовательно, давление в ней необходимо 
понизить. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Проверка тормозов (Brake Check) 

 
Рис. 15. Лист проверки тормозов показывает блокировку передних колес. 
 
Этот лист нужен для проверки тормозного баланса. Если тормоза работают правильно то на графике скоростей колес 
не должно быть резких провалов, свидетельствующих о блокировке колес. Если таких провалов больше на передних 
колесах то баланс необходимо переместить назад, а если провалов больше на задних колесах то вперед. 
 
График продольных перегрузок показывает то, как создается тормозное усилие. Наибольшие отрицательные значения 
означают, что машина тормозит лучше. 
 
Графики положения газа и тормоза показывают что вы делаете в это время на трассе. 
 
Погода (Weather) 

 
Рис. 16. Погода и температура двигателя (На 14 круге был произведен питстоп) 
 
Здесь показаны изменения температуры трассы и воздуха на протяжении сессии плюс температура воды и масла. 
 
Чем теплее, тем большие нужны  большие воздухозаборники для тормозов и двигателя и меньше давление в шинах. 
 
 



Отчет о круге (Lap Report) 

 
Рис. 17. Отчет о круге – сравнение двух кругов. 
 
Здесь можно посмотреть, как распределены ускорения и торможения по дистанции круга. 
 
Зеленым показаны зоны с полным газом, красным зоны торможения и синим/серым зоны с частично открытым газом. 
 
Сравнение двух кругов показывает вам, на сколько дольше вы оставались с открытым газом и на сколько позже 
тормозили по сравнению с предыдущими кругами. 
 
Также здесь отображаются максимальные обороты двигателя и включенные передачи. Во время сравнения двух 
кругов нажмите на кнопку “Play” после чего курсор начнет двигаться, и вы наглядно в реальном времени увидите 
потери и отыгрыши времени на круге. 
 
Отчет по каналам (Channel Reports) 

 
Рис. 18. Отчет по каналам 
 
Отчет по каналам обеспечивает вас данными в числовом представлении. 
 



Для того чтобы добавить новые каналы нужно щелкнуть ПКМ → Properties → Add, после этого появится список 
доступных каналов. 
 
Полезными являются сравнения средней скорости, положения тормоза и газа между кругами во время одной сессии. 
 
Близкие значения средней скорости являются показателями того, что машина управляется стабильно. 
 
Большие средние значения ускорения показывают что водитель имеет возможность начинать разгоняться раньше и 
сохранять эту скорость на протяжении всего круга. Также это отражается в увеличении средней скорости. 
 
Когда эти значения начинают уменьшаться это наводит на мысль что уровень сцепления с дорогой начинает 
понижаться и стремится к пределу. В то время как сцепление уменьшается водитель должен чаще использовать 
меньше газа в поворотах для уменьшения эффекта недостаточной или избыточной поворачиваемости. 
 
Показатель среднего положения педали тормоза аналогичен показателю среднего положения педали газа. Если 
значения начинают понижаться после нескольких кругов это сигнал того, что машина не едет так быстро как должна, 
и поэтому требуется меньшее тормозное усилие, для того чтобы ее замедлить. 
 
5. Установки (Setup) 
 
Круг перегрузок (Traction circle) 

 
Рис. 19. График перегрузок X-Y зависимость. 
 
Вы сможете изменить масштаб графика, изображённого на этом рабочем листе, чтобы можно было увидеть отдельные 
сектора трассы. 
 
«Сила тяги» это графическое представление силы «G», действующей на протяжении всей трассы. 
 
Этот график даёт вам возможность сравнить уровень сцепления  между различными настройками и конфигурацией 
шин. 
 
Вы сможете увидеть эту зависимость, создав график поперечной силы «G»(X) и продольной силы «G»(Y). (ПКМ  → 
Add → Scatter Plot) 
. 
Поперечная сила «G» основывается на силе, возникающей при повороте (отрицательное значение при правом 
повороте, положительное значение при левом повороте). 
 
Продольная сила «G» основывается на силе, возникающей при разгонах и торможениях (положительное значение при 
разгоне и отрицательное при торможении). 
 
Большое значение поперечной силы «G» (больше, чем ноль, либо положительное, либо отрицательное) означает, что у 
машины очень хорошее сцепление с дорогой. 



Маленькое значение продольной силы «G» означает, что машина тормозит плавно (больше, чем ноль, значение -1,6G 
значит, что торможение жестче, чем при значении -1,00G), большое положительное значение означает, что машина 
разгоняется сильнее. 
 
Эта величина ограниченна качеством сцепления шин. Качество сцепления шин зависит от типа и скорости их износа. 
Важно знать, что максимум сцепления можно добиться не только качественным сцеплением шин. Для примера, шины 
могут сгенерировать максимальную силу 1,5G в повороте, когда вы идёте накатом. 
 
При ускорении или торможение появится дополнительная сила «G». 
 
Качественные шины могут обеспечить силу 1,5 G. Этот предел может быть превышен, так как резина со временем 
теряет сцепные свойства и начинает скользить. 
 
Если шины генерируют в поворотах силу 1G, а ускорение или торможение 0,5G(1G поперечной силы + 0,5G 
продольной силы = 1,5G). 
 
Теоретически, лучший круг получится, если шины сохранят максимальное сцепление с дорогой. 
 
Диаграмма, представленная ниже показывает этот идеал. 
 

 
Рис. 20. Идеальное распределение силы тяги. 
 
На деле, к сожалению, этого не добиться. 
 
Диаграмма, представленная ниже демонстрирует разницу между квалификационным кругом на мягкой и на 
изношенной средней резине после 22 кругов в Дубае на Феррари 550 Маранелло (оранжевым выделена квалификация, 
зеленым - гонка). 
 
Я нарисовал несколько линий, которые полнее иллюстрируют график. 
 
Этот график показывает, что у свежей мягкой резины больше сцепления, чем у изношенной средней резины, которая 
проехала 20 кругов. 
 
Это позволяет лучше проходить повороты и эффективней тормозить. 
 
Чтобы убедится в этом, можете сравнить второй и последний круги. Если сцепные свойства будут ухудшаться, 
возьмите жёсткий тип резины или зайдите на ранний питстоп. 
 
 
 
 
 
 
 



 
Рис. 21. Изменение перегрузок по ходу износа резины. 
 
Трансмиссия (Gear) 

 
Рис. 22. Точечный график работы трансмиссии 
 
На этом рабочем листе представлен точечный график, в котором рассматривается зависимость оборотов двигателя от 
скорости. Этот график позволяет вам контролировать провалы между передачами. 



Каждая линия представляет собой одну передачу. Каждая передача обозначается своим цветом, первая передача 
обозначается светло синим, она слева, шестая оранжевым, она справа. 
 
Когда выбираешь передаточное число, предыдущая передача должна заходить на следующую так чтобы после 
каждого переключения двигатель выдавал максимальную выходную мощность. 
 
График выше показывает ход переключения передач для Феррари 550 Маранелло в Дубае. Максимальная выходная 
мощность располагается между 6000 и 7500 оборотов/минуту, это где-то 600 лошадиных сил, в идеале такие обороты 
двигателя должны сохраняться на протяжении всего круга. 
 
Для каждой машины эти характеристики различны и их можно посмотреть в демонстрационном зале в самой игре. 

 
 
В классах GT и трассах с узкими шпильками длинная первая передача, при которой обороты двигателя падают ниже 
диапазона оптимальных оборотов, может быть полезна, потому что вырабатываемая малая мощность на низких 
оборотах машина с меньшей вероятностью приведёт к пробуксовке колёс, приводящей к износу резины и 
закручиванию. 
 
Если обороты спадают медленно, машина не будет быстро ускоряться, что приведёт к потере времени. 
 
Лучше всего ставить большой промежуток между первыми передачами и уменьшать его в высших передачах. Потому 
что на высокой скорости аэродинамическое сопротивление повышается, так что двигателю приходится тратить 
больше энергии, чтобы дойти до максимальной выходной мощности. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Двигатель (Engine RPM) 

 
Рис. 24. Гистограмма оборотов двигателя 
 
На этом рабочем листе представлена гистограмма, показывающая механизм переключения передач. Поскольку график 
«передачи» даёт представление о каждой передачи, этот график даёт представление о зависимости оборотов двигателя 
от времени. 
 
Эта диаграмма подобна кривой мощности в демонстрационном зале. Длинный кусочек слева свидетельствует о том 
что включена более высокая передача, чем нужно на самом деле. 
 
Также можно это посмотреть на графике оборотов в закладке «GTR2 Analysis graph». Если обороты снижаются 
слишком быстро двигатель будет менее производительным, что в лучшем случае приведёт к потери времени. 
 
Пик диаграммы должен быть равным или незначительно меньше в месте, где достигается максимальная выходная 
мощность (в этом случае 7200оборотов/минуту). На представленной диаграмме, пики диаграммы не равны, это 
означает, что передачи переключаются слишком рано. 
 
Исключение из этого правила - это длинные гонки на выносливость, где передачи переключают раньше, затрачивая 
меньший ресурс двигателя и стараясь сберечь его. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Распределение веса (Weight Transfer) 

 
Рис. 25.  Распределение веса 
 
На этом рабочем листе представлены графики реакции машины на торможение и разгон. Внезапное изменение 
высоты посадки машины может вызвать проблемы. 
 
При жёстком торможение передняя часть опускается, а задняя – поднимается, вес машины перемещается вперёд. При 
ускорении задняя часть опускается, а передняя – поднимается. 
 
С помощью настроек подвески можно изменить распределение веса. 
 
Продольная сила «G» показывает, какое тормозное усилие (отрицательное значение) и ускорение (положительное 
значение) было приложено. Чем  дальше от нуля, тем больше было приложено силы. 
 
Графики ускорения и торможения дают представления о том, что послужило причиной изменения высоты посадки 
машины. 
 
Избыточная поворачиваемость (Overster) 

 
Рис. 26.  Избыточная поворачиваемость 
 



На этом рабочем листе представлены графики, дающие представления о том, как машина проходит повороты. 
 
Чтобы работать правильно на этом листе важно убедится, что ограничитель поворота колёс отображаемый в Мотеке, 
и тот, который вы используете в игре одинаковы. 
 
По умолчанию угол поворота 15 градусов. Чтобы увеличить это значение в Мотеке выберите (Tools  → Maths  → 
GTR2 Analysis  → Constants  → Steering Lock and click Edit). 
 
Избыточная поворачиваемость – положительное значение, недостаточная поворачиваемость - отрицательное. 
 
Этот график показывает разницу между углом поворота, который используете вы и на сколько теоретически можно 
было повернуть руль в данном повороте. 
 
Главное стараться сохранить значение как можно ближе к нулю. На практике же значения от -5 до 1 означают, что 
машина управляется верно. Чтобы понять, что вы делаете неправильно при вождении, не стоит ориентироваться 
только на этот график, его следует использовать наряду с другими. 
 
График поперечной силы «G» показывает, как много силы затрачено при повороте (отрицательное значение при 
правом повороте, положительное - при левом). Большое значение (больше нуля) означает, что у машины хорошие 
сцепные свойства. 
 
Также можно посмотреть, как влияет подвеска на сцепные свойства. 
 
График проскальзывание колёс показывает разницу в скорости между задними колёсами. Этот график помогает в 
настройки дифференциала и помогает понять, где была включена низшая передача раньше нужного. 
 
Разница в скорости при ускорении означает, что дифференциал не блокирует достаточную пробуксовку колёс.  
 
Повышение мощности дифференциала уменьшит разницу в скорости. 
 
Разница в скорости при торможении означает, что выбрана низшая передача, и задние колёса блокируются. Это может 
вызвать занос – понижайте передачи медленнее. 
 
6. Подвеска. 
 
Наличие хорошо настроенной подвески это ключевой момент конкурентоспособной машины. Используйте Мотек, как 
возможность увидеть, как влияет изменения подвески на время круга. 
 
Большая возможность регулировки подвески даёт возможность ужесточение или смягчения силы пружины с точной 
настройкой сжатия, отдачи, стабилизатора поперечной устойчивости и уплотнения. 
 
Общее представление о подвеске(Suspension Overview) 

 
Рис. 27. Общее представление о подвеске 



На этом рабочем листе представлены графики, дающие общее представление работе подвеске и посадки машины в 
сравнении с количеством топлива. 
 
График «высота посадки автомобиля» показывает расстояние между автомобилем и дорогой. Высота посадки 
автомобиля устанавливается в гараже, но на трассе посадка будет ниже из-за давления веса машины на пружину. 
 
Со временем посадка машины может увеличиваться, так как расход топлива уменьшает вес машины. 
 
Цель установки высоты посадки: в любой момент значение не должно быть равно нулю. При нулевом значении 
машина касается земли, что может вызвать проблемы. 
 
Демпфер (амортизатор) передний левый, правый; задний левый, правый (Damper FL, FR, RL, RR Histograms) 

 
Рис. 28.  Ход подвески заднего левого колеса без амортизатора 
 
На следующих четырёх рабочих листах данные представлены для каждого колеса в отдельности. На этой гистограмме 
представлена зависимость скорости демпфера (амортизатора) по X и времени по Y. 
 
Эта гистограмма показывает время, затраченное подвеской на обратный ход рессоры или сжатие. 
 
При низкой посадке машины и мягкой пружине, гистограмма будет выглядеть, как показано выше, без пробелов и без 
большого количества красных и оранжевых секторов. Это означает, что пружина движется очень быстро и машина 
задевает дном землю. На игровых повторах видно искры из под машины, когда так происходит. 
 
Два больших выступа на границе -+400мм/с показывают, где подвеска движется быстрее, чем 400мм/с. 400 - это 
предельный внутриигровой интервал. Старайтесь избегать впадин и выступов, как на этой схеме. 
 
Лучше всего иметь подвеску, наклоненную по направлению к обратному ходу амортизатора. 
 
Самое лучшее руководство  по настройки подвески, это указания Кони: 
Повышение контроля сжатия. 
Шаг 1. Поставьте все четыре демпфера (амортизатора) на минимум. 
Шаг 2. Пройдите несколько кругов, чтобы понять поведение машины. Не обращайте внимание на крен кузова, а 
сосредоточьтесь на том, как машина ведёт себя на кочках. 
Шаг 3. Увеличьте сжатие на три позиции на всех четырех амортизаторах. Пройдите несколько кругов. Снова 
увеличьте сжатие на три позиции. Продолжайте делать так, пока не почувствуете тряску на кочках. 
Шаг 4. Ослабьте сжатие на две позиции. Нежелательно, чтобы оба передних и задних демпфера (амортизатора) 
совпадали. Делайте заметки о впечатлениях. 
Повышения контроля отдачи (обратного хода амортизатора). 
Шаг 1. Начните сначала, используя нетронутые настройки сжатия. Сделайте обратный ход рессоры мягким. Пройдите 
несколько кругов внимательно следя, как машина входит в поворот. 
Шаг 2. Увеличьте обратный ход амортизатора на три позиции. Пройдите несколько кругов. Вы должны почувствовать 
плавность хода, без резких рывков или внезапных кренов. 



Шаг 3. Увеличивайте на три позиции или более пока не добьётесь плавности. Если вы почувствовали, что сильно 
увеличили, то уменьшите на две позиции. 
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Рис. 29.  Ход подвески заднего левого колеса 
 
Подвеска стала жёстче, надёжнее, а линии гистограммы зеленее. 
 
Подвеска, процентное соотношение (Suspension %) 

 
Рис. 30. Ход подвески всех четырех колес в процентном соотношении 
 
На этом рабочем листе представлена гистограмма процентного соотношения всех четырёх колёс друг к другу. 
 
Эта гистограмма показывает общий процент времени, затраченного на каждое движение демпфера (амортизатора).  
 
Лучше смотреть этот график при масштабировании в определённом секторе трассы, чем смотреть на весь круг. 
 



Центр каждой гистограммы показывает, где пружина движется относительно медленно. Чем дальше значение от 
центра, тем быстрее движется подвеска. В идеале все четыре колеса должны двигаться с одинаковой скоростью и 
четыре гистограммы должны быть симметричны и похожи между собой. 
 
Подвеска: передняя; задняя; передняя левая, правая; задняя левая, правая  
(Front Susp, Rear Susp, FL Susp, FR Susp, RL Susp, RR Susp Graphs) 

 
Рис. 31.  Графики работы подвески всех четырех колес 
 
На этом рабочем листе представлены графики хода подвески для всех четырёх колёс. 
 
График «высота посадки кузова» показывает высоту положения каждого колеса. Большая разница в значении между 
правым и левым колесом означает, что машину закручивает. Более жёсткий «стабилизатор поперечной устойчивости» 
и более жёсткая пружина помогут ослабить крен кузова. Если эти графики показывают ноль, значит, машина касается 
земли. 
 
Позиция демпфера (амортизатора) показывает, как сжимается подвесная пружина. Скорость этого движения 
контролируется установками жёсткости сжатия/отбоя  амортизатора. 
 
При большом значение жёсткости пружины будет меньше шансов закончить гонку из за сломанной подвески. Более 
мягкая  пружина делает обратный ход амортизатора более быстрым, однако, нужны большие значения  параметра 
отбоя амортизаторов, чтобы остановить подпрыгивающий автомобиль. 
 
Скорость демпфера (амортизатора) показывает, как быстро движется подвесная пружина. 
 
Отрицательное значение если пружина разжимается и положительное, если пружина сжимается. 
 
Настройки пружин должны быть настолько мягкими чтобы , чтобы колёса следовали профилю дороги, без скачков. 
Плохая настройка пружин может привести к потере сцепления с дорогой и доставить проблемы с управление т.к. 
машина будет подпрыгивать. 
 
Если пружины пережаты, они будут не в состоянии быстро реагировать, вследствие этого подвеска не сможет 
выдержать повторных ударов, таких, как проезд по неровным паребрикам в Монце. 
 
 
 
 
 
 
 
 
 
 
 



Приложение 1:  Горячие клавиши в MoTeC. 
 
VIEWS 
F8 Окно данных 
C Окно каналов 
V Окна значений вкл/выкл 
Esc Вернуть фокус на рабочий лист 
 
DATA 
F4 Слои вкл/выкл 
N Следующий круг 
P Предыдущий круг 
F9 Режим привязки по времени/дистанции 
F8 Показать окно Данные (Data) 
J Показать основной канал однм/разными цветами 
Ctrl+F Выбрать быстрейший круг в выбранном файле 
Q Поменять главный круг и сравниваемый круг 
 
GRAPH 
Left / Right Arrows Перемещение курсора 
Ctrl + Left / Right Arrows Быстрое перемещение курсора 
Up / Down Arrows Увеличение по горизонтали +/- 
F2 Увеличение по горизонтали - максимальное отдаление 
W Горизонтальное увеличение - по умолчанию 
Shift + Left / Right Arrows Перемещение области обзора влево/вправо 
F3 Разница вкл/выкл 
E Статус и ошибки вкл/выкл 
G “Все в одном окне” вкл/выкл 
 
WINDOWS HOT KEYS 
Alt+Буква Выбор из основного меню пункта начинающегося на нажатую букву. 
Tab Перейти на следующую область 
Shift+Tab Перейти на предыдущую область 
Enter Активизировать кнопку выбранную по умолчанию 
Esc Закрыть или отменить открытое окно 
Arrow Keys Перемещение списка вверх вниз, выбор пункта меню и т.д. 
Пробел Активировать кнопку или поставить галочку                          
Ctrl+Tab Следующая страница в окне с закладками. 
Shift+Ctrl+Tab Предыдущая страница в окне с закладками 
 
FILE 
Ctrl+O Открыть файл 
Ctrl+A Закрыть все файлы 
Ctrl+S Сохранить все рабочие листы 
 
GENERAL 
Ctrl+P Распечатать рабочий лист 
Fl Помощь      
 
EDIT 
Ctrl+X Вырезать компонент 
Ctrl+C Скопировать компонент 
Ctrl+V Вставить компонент 
Delete Удалить компонент 
 
 
LAYOUT 
F7 Выбрать рабочий лист 
Ctrl+F7 Менеджер слоев 
0..9 Выбрать рабочий лист с соответствующим номером 
Ctrl+ 0..9 Выбрать рабочую книгу с соответствующим номером 
Fl 1 Предыдущий рабочий лист 
F12 Следующий рабочий лист 
Ctrl+F 11 Предыдущая рабочая книга 
Ctrl+F 12 Следующая рабочая книга 



 
TOOLS 
Ctrl+D Окно деталей 
Ctrl+E Редактор каналов 
Ctrl+U Статус каналов 
Ctrl+M Редактор математических параметров 
Ctrl+T Листы с установками 
 
ACTIVE CHANNEL 
PgUp, PgDn Выбрать активный канал 
Ctrl+H Скрыть активный канал 
Ctrl+Delete Удалить активный канал 
Ctrl+Shift+M Настроить активный канал 
Ctrl+Shift+S Посмотреть статус активного канала 
Ctrl+Shift+F Отфильтровать активный канал 
Ctrl+Shift+O Масштаб и смещение активного канала 
Ctrl+Shift+Z Ноль активного канала 
Ctrl+N Свойства активного канала 
 
COMPONENTS GENERAL 
F5 Свойства компонента 
Tab Переключится на следующий компонент    
Shift+Tab Переключится на предыдущий компонент 
L Легенда вкл/выкл 
G “Все в одном окне” вкл/выкл 
S Стиль отображения 
Delete Удалить выбранный компонент 
 
GRAPH COMPONENT 
 
Graph Display 
E Статус и ошибки вкл/выкл 
F3 Разница вкл/выкл 
L Легенда вкл/выкл 
M Измерения вкл/выкл 
 
Graph Zoom 
Keyboard: 
Up / Down Arrows Увеличение по горизонтали +/- 
F2 Увеличение по горизонтали - максимальное отдаление 
W Горизонтальное увеличение - по умолчанию 
Alt+Up / Down Arrows Увеличение по вертикали +/- 
Alt+F2 Увеличение по вертикали - максимальное отдаление 
Mouse: 
Double Click, move, click Увеличение по горизонтали 
Alt + Double Click, move, click Увеличение по вертикали 
Ctrl + Double Click, move, click Увеличение выбранной области 
 
Graph Pan 
Keyboard: 
Shift + Left / Right Arrows Перемещение области обзора влево/вправо 
Shift + Up / Down Arrows Перемещение области обзора вверх/вниз 
F Перемещение области обзора вперед 
Back Перемещение области обзора назад 
H Перемещение области обзора в зону курсора 
Mouse: 
Click + drag on the horizontal axis Перемещение области обзора по горизонтали 
Click + drag on the vertical axis Перемещение области обзора по вертикали 
Click + drag on the horizontal scroll bar Перемещение области обзора по горизонтали 
Click + drag on the vertical scroll bar Перемещение области обзора по вертикали 
 
Graph Cursor 
Keyboard: 
Left / Right Arrows Перемещение курсора 
Ctrl + Left / Right Arrows Быстрое перемещение курсора 



Shift+F7 Поставить метку 
Y Стиль курсора 
Home Переместить курсор в левую часть экрана 
End Переместить курсор в правую часть экрана 
 
Graph Alignment Offsetting  
Keyboard: 
O Вкл/выкл оси смещения 
Ctrl+Shift+Arrows Перемещать основной круг 
Alt+Shift+Arrows Смещать сравниваемый круг 
 
 
Приложение 2: Коды трасс и машин из GTR2 для MoTeC. 
 
Машины 
 
BMW M3GTR 
BMW Motorsport - 04142 G2  
BMW Motorsport - 04143 G2 
 
BMW Z3M 
JMT Racing-03115-NG3 
 
Chevrolet Corvette  
Excelsior-03106-G2 Excelsior - 04108 - G2 
 
Gillet Vertigo 
Belgian Racing - 03100 - G2 
Belgian Racing - 04100 - G2 
Ice Pol Racing Team - 04101 - G2 
 
Lotus Elise 
Campus Automobile - 03118 - G3 
Campus Automobile - 04116 - G3 
 
Morgan Aero 
Aero Racing-03107-G2 
 
Mosler 
Perspective Racing - 03104 - G2 
Rollcentre Racing - 03101 - G2 
 
Porsche 996 Cup  
Almeras Freires - 03110 - G3  
Land Motorsport - 03117 - G3  
Markant Racing - 04121 - G3 
Muhlner Motorsport - 04123 - G3 
Muhlner Motorsport - 04124 - G3 
Ruffier Racing - 03113 - G3  
Signa Racing-03111 -G3  
Signa Racing-04111 -G3 
 
Porsche 996 GT2  
AD Sport-03102-G2  
PSI Motorsport - 04103 - G2  
RTM Racing-03105-G2 
 
Seat Toledo 
Darro Motorsport - 03103 - G2 
 
Viper Competition Coupe 
US Carworld Racing - 04115 - G3 
 
Chrysler Viper 
Force One Festina - 03004 – GT 



Force One Festina - 03005 - GT  
Force One Festina - 04032 - GT  
Larbre Competition - 03001 - GT  
Larbre Competition - 03017 - GT  
Megadrive - 03037 - GT  
Paul Belmondo Racing - 03024 - GT  
Paul Belmondo Racing - 03025 - GT  
Roos Optima Racing - 03011 - GT  
Scuderia Veregra - 04035 - GT  
Zakspeed-03126-G2 
Zwaans- 03018 - GT  
Zwaans - 04009 - GT  
Zwaans - 04010 - GT 
 
Ferrari 550 
BMS Scuderia Italia - 03022 - GT  
BMS Scuderia Italia - 03023 - GT  
BMS Scuderia Italia - 04001 - GT  
BMS Scuderia Italia - 04002 - GT  
Care Racing-03021 -GT  
Care Racing - 04003 - GT  
Jmb550 - 03009 - GT  
Jmb550 - 03010 - GT  
Wieth - 03016 – GT 
Wieth - 04022 - GT 
 
Ferrari 575 
GPC-04011 -GT 
Ferrari 575\GPC - 04013 - GT 
Ferrari 575\Jmb575 - 03009 - GT 
Ferrari 575\Jmb575 - 03010 - GT 
Ferrari 575\Jmb575 - 04017 - GT 
Ferrari 575\Jmb575 - 04018 - GT 
Ferrari 575\Jmb575 - 04019 - GT 
 
Lamborghini Murcielago 
DAMS - 04024 - GT 
DAMS - 04026 - GT 
Reiter Engineering - 03036 - GT 
Reiter Engineering - 04029 - GT 
 
Lister Storm 
Creation Autosportif - 03006 - GT  
Creation Autosportif - 03019 - GT  
Creation Autosportif - 04027 - GT  
Lister Racing - 03014 - GT  
Lister Racing - 03015 - GT  
Lister Racing - 04014 - GT 
 
Maserati MC12 
AF Corse - 04033 - GT 
AF Corse - 04034 - GT 
 
Porsche 993 GT2 
Alda Competition - 03038 - GT 
Proton Competition - 03012 - GT 
 
Saleen S7R 
Graham Nash Motorsport - 03007 - GT  
Graham Nash Motorsport - 03008 - GT  
Graham Nash Motorsport - 04028 - GT  
Konrad Motorsport - 03002 - GT  
Konrad Motorsport - 04004 - GT  
Ray Mallock Limited - 04007 - GT  
Ray Mallock Limited - 04008 - GT  



Vitaphone Racing Team - 04005 - GT 
 
Ferrari 360 
Auto Palace - 03058 - NGT 
Cirtek Motorsport - 04072 - NGT 
Darro Motor Racing - 04058 - NGT 
GPC Giesse - 04064 - NGT 
GPC Giesse Squadra Corse - 04062 - NGT 
JMB Racing - 03052 - NGT 
JMB Racing - 03053 – NGT 
JMB Racing - 04067 - NGT 
Kutemann - 03068 - NGT 
Mastercar-03071 -NGT 
Menx - 03057 - NGT 
Mik Corse - 04087 - NGT 
Scuderia Ecosse - 04065 - NGT 
Team Maranello Concessionaires - 03088 - NGT 
Team Maranello Concessionaires - 03089 - NGT 
Veloqx Motorsport - 03080 - NGT 
Yellow Racing - 03070 - NGT 
 
Nissan 350Z 
RJN Motorsport - 04085 - G3 
 
Porsche 996 GT3 RS 
AB Motorsport - 03064 - NGT 
AB Motorsport - 04056 - NGT 
Alda Competition - 03056 - NGT 
Autorlando - 03066 - NGT 
Autorlando - 03067 - NGT 
Cirtek Motorsport - 03054 - NGT 
Cirtek Motorsport - 03055 - NGT 
Cirtek Motorsport - 04073 - NGT 
Desbrueres - 03065 - NGT 
EBRT-04186-NGT 
Emeraude Racing - 04105 - NGT 
EMKA-03061 -NGT 
Eurotech - 03074 - NGT 
Eurotech - 03075 - NGT 
Freisinger - 03050 - NGT 
Freisinger-03051 -NGT 
G Tec - 03062 - NGT 
Graham Nash - 04070 - NGT 
JP Racing - 04059 - NGT 
JVG - 03085 - NGT 
JVG - 03086 - NGT 
JVG - 04063 - NGT 
JWR-04071 -NGT 
MAC Racing - 03090 - NGT 
Machanek Racing - 04061 - NGT 
Motor Competition - 03063 - NGT 
Proton - 03069 - NGT 
Proton - 04068 - NGT 
Proton - 04069 - NGT 
RWS - 03077 - NGT 
RWS - 03099 - NGT 
Scuderia Veregra - 04089 - NGT 
Seikel - 03072 - NGT 
Seikel - 03073 - NGT 
Seikel - 04075 - NGT 
T2M - 03084 - NGT 
Vonka Racing - 04057 - NGT 
 
Porsche 996 GT3 RSR  
Autorlando Sport - 04066 - NGT  



Freisinger - 04050 - NGT  
Freisinger - 04077 - NGT  
Freisinger - 04099 - NGT  
Gruppe M - 04088 - NGT  
Machanek Racing - 04060 - NGT 
 
TVR 
Chamberlain Motorsport - 04154 - NGT 
RSR Motorsport - 04153 - NGT 
 
Трассы 
 
2003 Circuits 
3Anderstorp 
3Barcelona 
3Brno 
3Donington 
3Enna 
3Estoril 
3Magny 
3Monza 
30schersleben 
3Spa 

Anderstorp 2003  
Barcelona 2003  
Brno 2003  
Donington 2003  
Enna-Pergusa 2003  
Estoril 2003  
Magny-Cours 2003  
Monza 2003  
Oschersleben 2003  
Spa 2003 

 
2004 Circuits 
4Brno 
4Donington 
4Dubai 
4lmol 
4Magny 
4Monza 
40schersleben 
4BOschersleben 
4Spa 
4GPValencia 
4NAValencia 
4NGValencia 
4SHValencia 
4Zhuhai 

Brno 2004  
Donington 2004  
Dubai GP 2004  
Imola 2004  
Magny-Cours 2004  
Monza 2004  
Oschersleben 2004  
Oschersleben B-course 2004  
Spa (new busstop) 2004  
Valencia 2004  
Valencia National 2004  
Valencia Long 2004  
Valencia Short 2004  
Zhuhai 2004 

 
Track Variations 
CDubai 
CLMagny 
GPHockenheim 
IDubai 
JNMonza 
NAnderstorp 
NBarcelona 
nDonington 
NDubai 
NTHockenheim 
NTMagny 
SAnderstorp 
SHHockenheim 
 
 
 
 
 
 
 
 
 
 
 

Dubai Club  
Magny-Cours Club  
Hockenheim GP  
Dubai International  
Monza Junior  
Anderstorp North  
Barcelona National  
Donington National  
Dubai National  
Hockenheim National  
Magny-Cours National  
Anderstorp South  
Hockenheim Short 


